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Welcome to the 2013
Reform Symposium E-Conference!

Important Instructions for Presenters and Moderators:

Check your own microphone/ speakers by running Tools > Audio > Audio Setup Wizard
Tum on chat capability for all participants (drop-down at the top of the participant window)
Enable profiles: Tools > Profiles > Show Everyone

Look through these pre-loaded slides so that you are familiar with tham.

Upload your presentation when you are on tha page "PRESENTERS LOAD SLIDES HERE™
Discuss dulies belweaen the presanter(s) and moderalor. We recommend that the presenter
start the session and introduce himhersalf and the moderator supparis by watching and
interacting with the chat.

7. Move to the main “VWelcome" slide fill in the presenter name and session title, then leave this
shde up for participants as they come in.

1.
2.
3.
4.
5.
6.

http://IReformSymposium.com
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reform symposium

worldwide e.conference

Welcome!

Presenter: Denise Krebs @mrsdkrebs
Session Title: The World Needs Your Contribution:
How My PLN Changed Everything

While you are waiting:

. Configure microphone and speakers: Tools » Audio > Audio Setup Wizard
" To share your profile with others, enter information: Edit = Preferences = Profile
. To view tII!:.E profile of another participant: hover pointer over their name in the
articipants window
. 'ou may find it easier to read the chat if you “detach” and enlarge it {look for
the drop-down menui'n_l
. Please "tweet™ using hashtag #RSCON4
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Thanks to the 2013 Reform Symposium
Conference Sponsors & Supporters

OO\
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Blackboard,

collaborate
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Where in the world are you?

Bicderakor,

fPresenter:
Giwe gl participants whitaboard permssons for this slida, than turm ofT wihen you Bo 1o The next slide!

Participants:
Lok Bor thi “star™ icom bo the ket cick an i, them dick on the map to indicate whens wou @, You Can alko post your City/countrgftmeSwaather into

the chat!
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The World Needs Your Contribution

The World Needs
Your Contribution

How My PLN Changed Everything

Denise Krebs (@mrsdkrebs

olides and links at:
http://tinyurl.com/mrsdkrebsRSCON4
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About Me
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You Are a Genius

www.photovisi.com
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You Matter

o LT
. » v

. Matter E
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FIVE WAYS THE CONTRIBUTIONS OF

MY PLN HAVE CHANGED ME

CHOICE
LEA" NING —

GRAING
HON: WORK
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ON CHOICE

P

g i
.-I-

"When you teach a Chlld s@”methmg
you take away forever his chan;_e of

g drscouermg lt for h.]lim}srel P

Page 10.




Blackboard Collaborate ?? RSCON4 - ROOM 221 Oct 13, 2013 6:55:39 PM

Genius Hour Creations
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Need help getting ready for GH?

NEED HELP GETTING READY FOR
GENIUS HOUR?

Brainstoun and jfud aspivation. ..

10 Things You Love to Do and Learn
10 Things You Are Good At
10 Things You Wonder
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Master, Create, Learn, Innovate, Produce, or Serve
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More genius hour creations
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Disclaimer: Don??t Do Genius Hour Before YOU Are Ready

Disclaimer: Don’t Do Genius Hour

Before YOU Are Ready

In the post “10 reasons for Genius Hour; 10
signs it will fail” on her blog Invent to Learn,
Sylvia Martinez shares signs when genius
hour will fail. Read the article later, but for
now:

9. Doing Genius Hour
means I don’t have to
change anything else.
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Researcher??s Workshop
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Researcher??s Workshop Image
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How do you give CHOICE?

How do you give CHOICE?

Inpuiry projects for Social Shsdies

1 orally wk oy rsdecn oy her wkdiE
o Mot b |l b i Ty B

Ut S TS Teamning allows for choice on arcas of interest

Letting students design the projects themselvies, as long as it las o do with the leaming oulcome
L]

(Genius Hour!

MNexable Lise 1o |.'l:r|.‘|I]1|L1|: |’.Irl.1jl.'\i.'|:|- I pree choices m prodesnonal developmsnt | ofben Ll
taken what they dary they wani, s take what [ 3ee s

nesds also 1 alee folloe v and ooamiee o a8k whar
thane D
Students develop thetr awn BIG questsons lnmﬁlu'rn ".:'Il:ﬂmkr:lrgcr concept

allowing choice for tools they want w use w complete project
Interests n hobbics are important for conversation lessons | teach English to adults

Clwsice in prescatation siybe - anl, drama, postry, Prezl

Letting my student-teachers choose their own areas of inquiry in regards to teaching
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ON TRUST

™

can 'oa summml up in *::jﬂu?'cli’
Trust C ren.
NOTHING COULD BE MORE SIMPLE,

Of MORE DTFFLCULT

ON TRUST

T
Di%tu” IDE.t:auf-e.- h.
o= irus* thiHra.n We. musjr

¢ _{1’75* |t.arn fo *T‘u&{' E-u'r:-‘t-l‘it.ﬁ.

: and mn* of us were Lmjii‘jf

|
as tn'rir.:'lre.n

”’]ﬂ.i’ We. r:.n-uH 'nni( La_ {'Tuii'llrtl.

A
Jehg siall
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No longer this...

No longer this...

WS Ta

BEHAVIORIST - BY MRSDKREES

Hes km | Oclimg TedorpT

.50 YOU MAY HAVE
A PIECE OF CANDY!

I LIKE THE WAY YOU MADE
BOOD CHOICES TODAY.
YOU SAT QUIETLY

| AND LISTENED...

Behavigrist
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But this...

But this...

WWW . TOON D0 C O

Wow! Look what £
o :' |

2 --
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And this...

And this...

- BY MRSDKRE

i F i e BT T

HUMANIST

Education should be unhurried, 55

"1 Human character develops e
;h_"‘:_ T# like the unfolding of nature
I.E.'I#"‘! f- L ] ':I:E'.: .-ﬂ.-“- ..}..fl-l-“:‘—.i-:--\ -L-HI—' I-l-l;' = 5 i

1 } & [ | U ] " ]
LR Y 'i.'“ i:al' 1 EJ‘ F i F .'il-ti &

I'm building a model of a castle...
| know my teacher trusts me to

make choices and be responsible
for my learning.

i
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How is it that you establish mutual TRUST?

How is it that you establish mutual

TRUST?

T e s T tTaking the time o talk to them about things that matier o them

T o wemey. Bl T

gwing them choces amd :|.II-|:rwi|.1r_ I}Lﬁ_rp-'lm:' ﬂ'.L'_In;I. Eﬂ'ﬁilhlall‘l Iﬁl;\rguhm ¥ . il b i

TORCES,
Trawt alva drvslops when you acs eansposeni wiih tham
el 8k Fiow chottd Teedbahe

Just i time suppaot "

acting on teachable moments by bullding on things that happen in the classroom

tell them that 1 brest theme,. and then really fillow through wath opportunities for them o be trusted., does that make sense'’?
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ON LEARNING

ON LEARNING

"“There is no end to education.
It is not that you read a book,
pass an examination;

L

q{ a-{imish with education.

The whole of life,
from _the moment you aré n
to the moment,you die
is a process of learning."

~J. EFishramurt
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Learning is the product of the activity of learners.

LEARNING 1S-NoT THE PREDUES
JF FEACHING N W m
o e

o
| “
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The teacher is the chief learner in the classroom.

The keac}\e( 11 -hh?

~Donald Graves
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Kidwind
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Reading

Reading
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Student-Driven LEARNING
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Success
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Answering Questions

b o
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John Dewey brought teachers and students together

John Dewey
brought teacherﬁ i
out among the " :1: it
students and put. ,.:;
the students and
teachers
together.

~Daniel Schugurensky
History of Education
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How are you celebrating LEARNING in your classroom?

How are you celebrating LEARNING

in your classroom?

modelling leaning. ..sharsing wihai | leam'read/love oo

rweeting what they are dodng—shows them lsow awesome i think they are!
I'm constantdy sxpanding what | ko and the PO *
can. deliver be oy lnschers. [jemp in tha classraom
20 IrF o 10 SRpenence f

Hh:ll'ing puhl'il."l:.' ;ITﬂiIJ'iI]E I.-:ilrnmg I:h::r' harve heen -|j:rir.|g [TH] n:v;nr,gni.:re their l;ilmll'lhﬂ.l'llmvx

share

commsenbing on Useir blog posis

Blogging - class and teacher - helps demonstrate lots of things
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ON GRADING

ON GRADING

WWW. TOONDDD,CD

Igot a 45
in sclenci
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Rick Wormelli Quote
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Feedback
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How have you transformed GRADING?

How have you transformed

GRADING?

ssked stdents how they want 1o show their learming=-so different wiys to get the grade

| used b average all their marks.. now | focus on wihether of not ihey have showed masiery i the eod

[ve Teeen abdle v mfluence ediers oo dlow re-des end
self-reflection and peEr Py re-zakex Fvw sl mnffosmced vane o onet arerags
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ON HOMEWORK

ON HOMEWORK

b
# I kS .
T

g - '

| b

T

| w MR S

The best thing about baseball
is there's no homework.

~Dan Quisen e

B ot L2 :
S L “ . - W Lol
A = .:'.-| i ; ‘: S ey - = ;A
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My only homework is reading.
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Jack Andraka Phto

FPhoto by Benjamin Quinto on Wikimedia Commons
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Jack Andraka homework quote

| went online to a teenager’s best friends,
Wikipedia and Google--

(I cut everything
for my homework from
those two sources)...

18203 c0sclscollecl7=Nsallo

oallwelleelralToly=Ru B
aallc-ln Neallcallus
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I went
online to a
teenager’s
best
friends,
Wikipedia
and
Google...

Real Homework by Jack Andraka

...and T forlil information
leading to.a promising
. &dfﬁ"

cancei-,
~-Jack Andraka
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What do you say about HOMEWORK?

What do you say about

HOMEWORK?

el i miph b vl E'm b oy sk - 1
Ch i T g

nesds 1o be meaningful_..

Frarumy hioew i Bo-Frd g, ey e no much
hereodk ol av kil soliol Bt less ead L34 &
dih-lth Thenm %h, ®'s back 6o 3 iom of homewerk

[ am torm. | go back and forth. _have nofHSHly made up my mind. | dislike stupid homework.

PS hly iod dhbn'® lnarm haw to ply baseball becaise

ihere wasn't mme wah all the homeeade 1
dont gros ionless 7 adds value o
S hamony Brough chowes thay =
il £

I'm really liking the flipped modsl where class fime is put to befter use
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Wrapping Up

Wrapping Up

John Hattie - From Visible Learning, Part 1
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distribution of effects

Notice the O point - there is not much we do in education
that has a negative effect on student achievement
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

SO0 NOONhAWLNE

0.
11.Self-verbalization and self-questioning
.62
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

VWReNOWUAWNE

10.Creativity programs .65 (Creativity Rubric)
11.5elf-verbalization and self-questioning .62
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

PN A WNH

9. Meta-cognitive strategies .69
10.Creativity programs .65

11.5elf-verbalization and self-questioning .62
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

NOUTRWN R

8. Spaced vs. mass practice .71
9. Meta-cognitive strategies .69
10.Creativity programs .65

11.5elf-verbalization and self-questioning .62
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

ounhwN

7. Teacher-student relationships fostered .72
8. Spaced vs. mass practice .71

9. Meta-cognitive strategies .69

10.Creativity programs .65

11.5elf-verbalization and self-questioning .62
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

nihwne

6. Feedback .73

7. Teacher-student relationships fostered .72
8. Spaced vs. mass practice .71

9. Meta-cognitive strategies .69

10.Creativity programs .65
11.5elf-verbalization and self-questioning .62
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

ol i .

5. Reciprocal teaching .74

6. Feedback .73

7. Teacher-student relationships fostered .72
8. Spaced vs. mass practice .71

9. Meta-cognitive strategies .69

10.Creativity programs .65
11.5elf-verbalization and self-questioning .62
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

ol s

4. Teacher clarity .75

5. Reciprocal teaching .74

6. Feedback .73

7. Teacher-student relationships fostered .72
8. Spaced vs. mass practice .71

9. Meta-cognitive strategies .69

10.Creativity programs .65
11.5elf-verbalization and self-questioning .62
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

1.

2.

3. Providing formative assessments .90
4, Teacher clarity .75

5. Reciprocal teaching .74

6. Feedback .73

7. Teacher-student relationships fostered .72
8. Spaced vs. mass practice .71

9. Meta-cognitive strategies .69
10.Creativity programs .65
11.5elf-verbalization and self-questioning .62
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

. Plagetian programs 1.28

. Providing formative assessments .90

. Teacher clarity .75

. Reciprocal teaching .74

. Feedback .73

. Teacher-student relationships fostered .72
. Spaced vs. mass practice .71

. Meta-cognitive strategies .69

10.Creativity programs .65
11.5elf-verbalization and self-questioning .62

WONOUSWNH
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Above Average Methods by John Hattie (Effect size of .50 is equivalent to 1 grade improvement in
exam results.)

Above Average Methods by John Hattie

(Effect size of .50 is equivalent to 1 grade improvement
in exam resulits.)

1. Student self-assessment/self-grading 1.44
. Piagetian programs 1.28
. Providing formative assessments .90
. Teacher clarity .75
. Reciprocal teaching .74
. Feedback .73
. Teacher-student relationships fostered .72
. Spaced vs. mass practice .71
. Meta-cognitive strategies .69
10.Creativity programs .65
11.5elf-verbalization and self-questioning .62

el e N e T RV
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Visible Learning by John Hattie

T
-

s ...SO

" Teachers -

need to children
: can see

themselves

as their
own
teachers.
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Thank you to my PLN! Have a virtual cupcake!
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More From John Hattie

More From John Hattie

Watch John Hattie's YouTube videos -

http://youtu.be/sng4p3Vsu7Y - Part | - below
average effects

http://youtu.be/3pD1DFTNQf4 - Part 2 - above
average effects of teaching

Read his book - Visible Learning for Teachers.
Maximizing Impact on Learning
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Hear Jack Andraka??s ??Real?? Homework Story

Hear Jack Andraka’s “Real”

Homework Story

e TED Talk - http://youtu.be/g-ycQufragk4
e Huff Post Teen -

hitp:/fewwew huffingtonpost com/ 201 3/07/08/jack-andraka n 3562230 htmi

e How Open Access Empowered a 16-year
Old to Make Cancer Breakthrough

® Wlklpﬂdlﬂ article - hitp://en.wikipedia.orgfwikifJack Andraka
e \Watch 60 Minutes on October 13, 2013
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Books and Blogs You Should Read

Books and Blogs You Should Read

e On Choice, Trust and Learning

- Any blogs of the genius hour teachers - Find them
on the wiki - http://geniushour.wikispaces.com/
- Role Reversal by Mark Barnes

Classroom Habitudes and The Passion-Driven
Classroom by Angela Maiers

> Dangerously Irrelevant blog by Scott McLeod

- Essential Questions by Jay McTighe

- Who Owns the Learning? by Alan November

-~ Drive by Dan Pink
The Element by Sir Ken Robinson
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Books and Blogs You Should Read (continued)

Books and Blogs You Should Read

(continued)

e On Grading & Homework

- Joe Bower and others on grading moratorium
http:/ivrww.joebower.org/p/grading-moratorium.html

> Shawn Cornally - Standards Based Grading on
ThinkThankThunk blog

- Books, papers, and DVDs by Alfie Kohn:
http://www.alfiekohn.org/index.php

~ Books and videos by Rick Wormeli
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References to My Work

References to My Work

Most CC Attribution images from this slide show can
be found at:

http://iwww.flickr.com/photos/mrsdkrebs/sets/7215763
6009605876/

My Toondoos are available here.

Jack Andraka photo by Benjamin Quinto:
http://en.wikipedia.org/wiki/File:Jack_Andraka.|pg
My blog: http.//mrsdkrebs.edublogs.org

Link to blog post with all resources from this session:

http://tinyurl.com/mrsdkrebsRSCON4
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W reform symposium ol rscons srscons

Ot 11th to 13th wirrldvide & conlerence

s i nin i SR YOU TOP attending!

Huence: Believing Every Child Cam Achieve Their Dreams
Salorme Thomwas EL, Mahonal Edacahian Eapert, smd Awand-Wnning Teacher and Frncpal In Pralsdeiphes, FA

SESSION LYK - hetpes: ' sas eBumsnate com' d jrip ¥ d=008 00 pa s poond=ES000 0P 1 11
I the seaiion bnk desin’t work foe you, plesss copy snd paide mio youw browser.

Participants:

Thank you for atiending. In order for the recording 1o process, please exil the room by clicking "X at the upper
right of your screen, or going 1o the File > Exil. When you do a survey will come up giving you the opportunity 10
give feedback on this session!

Presenters:
1. Tum off the recording and ask pariicipants to leave the room.
2. Right-chick on parlicipant names o remave stragglers.

3. Go o Tooks > Maderator and unclick “allow new pamicipants 1o enter Session.

http:/l'www.futureofeducation.com/page/attending-rscon-2013
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